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USER MANUAL

1. Introduction

To all residents of the European Union

Important environmental information about this product
This symbol on the device or the package indicates that disposal of the device after its lifecycle
could harm the environment. Do not dispose of the unit (or batteries) as unsorted municipal
waste; it should be taken to a specialized company for recycling. This device should be
returned to your distributor or to a local recycling service. Respect the local environmental
rules.

L T doubt, contact your local waste disposal authorities.

Thank you for choosing Velleman! Please read the manual thoroughly before bringing this device into

service. If the device was damaged in transit, don't install or use it and contact your dealer.

2. Safety Instructions

A Keep this device away from children and unauthorized users.

Note that the camera head is made of metal and may cause short-circuits.

f Do not use in areas where explosive gasses reside.
Never insert the camera in energised/operational machines or equipment.

Misuse may lead to severe injuries or even death.

There are no user-serviceable parts inside the device. Refer to an authorized dealer for

é This is not a medical device hence it should never be used on humans or animals.
@ service and/or spare parts.
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3.

General Guidelines

Refer to the Velleman® Service and Quality Warranty on the last pages of this manual.

% @ Keep this device away from dust and extreme temperatures.

Protect this device from shocks and abuse. Avoid brute force when operating the device.
NP4

Familiarise yourself with the functions of the device before actually using it.

All modifications of the device are forbidden for safety reasons. Damage caused by user modifications
to the device is not covered by the warranty.

Only use the device for its intended purpose. Using the device in an unauthorised way will void the
warranty.

Damage caused by disregard of certain guidelines in this manual is not covered by the warranty and
the dealer will not accept responsibility for any ensuing defects or problems.

Warranty is limited to the device itself; installation and use of the included software is the sole risk of
the user.

Always allow the device to reach room temperature before switching it on.

Do not use the device if condensation forms inside the lens. Let the water evaporate before using
again.

The camera and gooseneck are waterproof and can be submerged in pH-neutral liquid (not acid or
alkaline). Never submerge the handle as this will cause irreversible damage. Keep the handle away
from rain, moisture, splashing and dripping liquids.

Avoid strong mechanical strains or vibrations. The bending radius of the gooseneck must be at least
6 cm.

Clean the CAMCOLI4 after each use.
Do not use when visible damage to the device is noticed.

4. Features

e ideal for checking hard-to-reach areas, e.g. behind walls, suspended ceilings, etc.

e 4 built-in white LEDs

e adjustable LED intensity.

5. Overview
Refer to the illustrations on page 2 of this manual.

1 LED brightness control 4  gooseneck (* 60 cm)

2 snapshot button 5 camera head with LEDs

3 handle 6  accessory tools: hook, magnet
6. Preparation

Installing the Driver on Windows XP or Earlier
On Windows XP® operating system (or earlier), proceed as follows:

1.

2.

Connect the camera to a free USB 2.0 port on your pc.

Note: Make sure to use USB 2.0 or higher. Correct operation is not guaranteed with USB 1.1.
Windows automatically recognises the device and installs the driver. Depending on the settings,
Windows may (not) display the message “Your new hardware is installed and ready for use”.

Your camera is now ready for use.

Installing the Driver on Windows Vista /7 7
For Windows Vista / 7, proceed as follows:

1.

2.

Connect the camera to a free USB 2.0 port on your pc.
Note: Make sure to use USB 2.0 or higher. Correct operation is not guaranteed with USB 1.1.
Insert the included CD-ROM in your pc.
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o
3. Double-click the setup icon g to start installation.

4. Follow the instructions of the installation wizard.

5. Double-click the Amcap icon on your desktop to run the software.
The installation is now complete and your camera is ready for use.
Attaching Tools

Slide the plastic clamp of the tool [6] over the narrow part of the camera head [5] until it snaps into
place.

e Attach the magnetic top to the camera to pick up small metal pieces from difficult to reach locations.

e Attach the hook to retract wires or other small objects.

7. Use
A Never insert the camera in energised/operational machines or equipment.

Windows XP
1. Connect the camera to a free USB 2.0 port on your pc.
2. Open My Computer and look for the “USB Video Device” to see live images.
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3. Insert the camera head [5] into the space you want to inspect.
Note: The gooseneck should easily manoeuvre into position. Do not apply force.
4. Turn the LED brightness button [1] to adjust the intensity of the LEDs on the camera head.

5. Press the snapshot button [2] to take a photo. The list of photos appears under the camera image.
You can copy, delete, or view the photos from here.

Windows Vista / 7
1. Connect the camera to a free USB 2.0 port on your pc.

2. Double-click the Amcap icon on your desktop to run the software.
In the Options menu, select Preview to see live images.

4. If more than one USB camera is connected to the pc, select the desired camera in the Devices
menu.

5. Insert the camera head [5] into the space you want to inspect.
Note: The gooseneck should easily manoeuvre into position. Do not apply force.
6. Turn the LED brightness button [1] to adjust the intensity of the LEDs on the camera head.
7. To capture a video file, first set the default folder and file name: choose File > Set Capture File.

w
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8. Choose Capture > Start Capture and click OK to confirm.
The pc now starts capturing the video file.

9. To stop, choose Capture > Stop Capture.

10. Press the snapshot button [2] to take a photo. The photo appears in a separate window. To save
the photo, choose File > Save.

11. When finished, close the Amcap program and unplug the camera from the USB port.

Software Overview
Note: Only for Windows Vista / 7.

File Set Capture File set the default folder and file name for recordings
Allocate File Space set size of recordings
Save Captured Video save recording manually to a desired location
Exit quit AmCap software

Devices list of devices that are connected to the software

Options Preview select to see live images
Video Capture Filter set parameters (white balance, exposure, etc.) and effects

(flip image, etc.)

Video Capture Pin set the size of the video window

Capture Start Capture start video capture
Stop Capture stop video capture
Set Frame Rate set the number of recorded frames per second
Set Time Limit set a maximum duration for the recording

8. Cleaning and Maintenance

e Unplug the device from the USB port.
e Wipe the device with a lint-free, soft anti-static cloth. Do not use abrasive solutions or solvents.
e Clean the gooseneck and camera with clean water after each use and let it dry before storing it.

9. Technical Specifications
pick-up element 1/6" CMOS
number of pixels 640 (H) x 480 (V)
viewing angle 56°
focus 6 cm
input interface USB 2.0
S/N ratio 46 dB
white balance auto
picture format JPEG, BMP
system requirements e  Windows® XP/Vista/Windows 7/Mac OS
e free USB 2.0 port.
IP rating IP66 (camera + flexible tube)
power supply 5 VDC via USB port
camera @14 x 72 mm
dimensions flexible tube 54 cm
USB cable 200 cm
operating temperature 0 —50°C
weight 310g¢g

Use this device with original accessories only. Velleman nv cannot be held responsible in the
event of damage or injury resulting from (incorrect) use of this device.

For more info concerning this product and the latest version of this manual, please visit our
website www.velleman.eu.

The information in this manual is subject to change without prior notice.

All registered trademarks and trade names are properties of their respective owners and are used only

for the clarification of the compatibility of our products with the products of the different manufacturers.
Windows, Windows XP, Windows Vista, Windows 7, are registered trademarks of Microsoft Corporation in
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the United States and other countries. Mac, Mac OS, are trademarks of Apple Inc., registered in the
United States and other countries.

© COPYRIGHT NOTICE

The copyright to this manual is owned by Velleman nv. All worldwide rights reserved. No part
of this manual may be copied, reproduced, translated or reduced to any electronic medium or otherwise
without the prior written consent of the copyright holder.

GEBRUIKERSHANDLEIDING
1. Inleiding

Aan alle ingezetenen van de Europese Unie

Belangrijke milieu-informatie betreffende dit product
Dit symbool op het toestel of de verpakking geeft aan dat, als het na zijn levenscyclus wordt
weggeworpen, dit toestel schade kan toebrengen aan het milieu. Gooi dit toestel (en eventuele
batterijen) niet bij het gewone huishoudelijke afval; het moet bij een gespecialiseerd bedrijf
terechtkomen voor recyclage. U moet dit toestel naar uw verdeler of naar een lokaal
recyclagepunt brengen. Respecteer de plaatselijke milieuwetgeving.

B cheu vragen, contacteer dan de plaatselijke autoriteiten betreffend de

verwijdering.

Dank u voor uw aankoop! Lees deze handleiding grondig voor u het toestel in gebruik neemt. Werd het

toestel beschadigd tijdens het transport, installeer het dan niet en raadpleeg uw dealer.

2. Veiligheidsinstructies
A Houd buiten het bereik van kinderen en onbevoegden.

Gebruik dit toestel niet nabij ontplofbare gassen.
De metalen kop van de camera kan in uitzonderlijke gevallen kortsluiting veroorzaken.
Steek de camera nooit in een ingeschakeld toestel.

Deze camera is niet geschikt voor medische doeleinden en mag nooit gebruikt worden op
mensen of dieren. Verkeerd gebruik kan ernstige letsels veroorzaken.

Er zijn geen door de gebruiker vervangbare onderdelen in dit toestel. Voor onderhoud of
reserveonderdelen, contacteer uw dealer.

3. Algemene richtlijnen
Raadpleeg de Velleman® service- en kwaliteitsgarantie achteraan deze handleiding.

Bescherm tegen stof en extreme hitte.
OO

Bescherm tegen schokken en vermijd brute kracht tijdens de bediening.
S

e Leer eerst de functies van het toestel kennen voor u het gaat gebruiken.

e Om veiligheidsredenen mag u geen wijzigingen aanbrengen. Schade door wijzigingen die de
gebruiker heeft aangebracht valt niet onder de garantie.

e  Gebruik het toestel enkel waarvoor het gemaakt is. Bij onoordeelkundig gebruik vervalt de garantie.

e De garantie geldt niet voor schade door het negeren van bepaalde richtlijnen in deze handleiding en
uw dealer zal de verantwoordelijkheid afwijzen voor defecten of problemen die hier rechtstreeks
verband mee houden.

e De garantie geldt enkel voor het toestel en is niet geldig voor de meegeleverde software.
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e Om beschadiging te vermijden, zet u het toestel best niet aan onmiddellijk nadat het werd
blootgesteld aan temperatuurschommelingen. Wacht tot het toestel op kamertemperatuur
gekomen is.

e  Gebruik het toestel niet indien er condensatie wordt gevormd binnenin de lens. Laat het vocht eerst
verdampen voor u het toestel opnieuw gebruikt.

e De camera en zwanenhals zijn waterdicht en zijn geschikt voor onderdompeling in een pH-neutrale
vloeistof (geen zuur of base). Onderdompeling van het handvat kan leiden tot onherroepelijke
schade. Bescherm het handvat tegen regen, vochtigheid en opspattende vloeistoffen.

e Plooi de zwanenhals niet overmatig; de plooistraal moet minstens 6 cm bedragen.
e Maak de CAMCOLI4 schoon na elk gebruik.
e  Gebruik geen zichtbaar beschadigde camera.

4. Eigenschappen

e ideaal voor het checken van moeilijk bereikbare plaatsen zoals achter een muur, binnenin een
verlaagd plafond, enz.

e 4 witte leds

e instelbare lichtsterkte van de leds.

5. Omschrijving

Raadpleeg de afbeeldingen op pagina 2 van deze handleiding.

1 helderheidregelaar leds 4  zwanenhals (+ 60 cm)
2 fotoknop 5 camerakop met leds
3 | handgreep 6  opzetstukken: haak, magneet

6. Voorbereiding

De driver installeren in Windows XP of eerdere versie

Voor een Windows XP®-besturingssysteem (of eerdere versie), gaat u als volgt te werk:

1. Sluit de camera aan op een vrije USB 2.0-poort op uw pc.

Opmerking: Gebruik een USB 2.0-poort of hoger. Een correcte werking is niet gegarandeerd bij
een aansluiting op een USB 1.1-poort.

2. Windows herkent het toestel automatisch en installeert de driver. Afhankelijk van de instellingen,
geeft Windows het bericht (of niet) “Your new hardware is installed and ready for use” ("Uw nieuwe
hardware is geinstalleerd en is gebruiksklaar™).

Uw camera is nu gebruiksklaar.

De driver installeren in Windows Vista / 7

Voor Windows Vista / 7, ga als volgt te werk:

1. Sluit de camera aan op een vrije USB 2.0-poort op uw pc.
Opmerking: Gebruik een USB 2.0-poort of hoger. Een correcte werking is niet gegarandeerd bij
een aansluiting op een USB 1.1-poort.

2. Plaats de meegeleverde CD-ROM in uw pc.

i
3. Dubbelklik op de setup-icoon g om de installatie te starten.
4. Volg de instructies in de installatiewizard.

5. Dubbelklik op de Amcap-icoon [P op uw bureaublad om de software op te starten.
De installatie is nu voltooid en uw camera is gebruiksklaar.

Opzetstukken

Schuif de plastic clip van het opzetstuk [6] over het vernauwde gedeelte van de camerakop [5] totdat

het vastklikt.

e Koppel het magnetisch opzetstuk aan de camera om kleine metalen voorwerpen op moeilijk
bereikbare plaatsen op te rapen.

e Bevestig de haak om kabels of andere kleine voorwerpen terug te trekken.
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7. Gebruik

A Steek de camera nooit in een ingeschakeld toestel.

Windows XP
1. Sluit de camera aan op een vrije USB 2.0-poort op uw pc.
2. Open My Computer en zoek naar “USB Video Device” om livebeelden te bekijken.
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3. Steek de camerakop [5] in de ruimte die u wenst te inspecteren.
Opmerking: De zwanenhals moet gemakkelijk kunnen bewegen. Gebruik dus geen kracht.
4. Draai aan de helderheidsregelaar [1] om de lichtsterkte van de leds in de camerakop te regelen.

5. Druk op de fotoknop [2] om een foto te nemen. De lijst met foto's verschijnt onder het
camerabeeld.

Van hieruit kunt u de foto's kopiéren, verwijderen of bekijken.

Windows Vista /7 7
1. Sluit de camera aan op een vrije USB 2.0-poort op uw pc.

2. Dubbelklik op de Amcap-icoon L op uw bureaublad om de software te draaien.
In het menu Options, selecteer Preview om livebeelden te bekijken.

4. Indien meerdere USB-camera's zijn aangesloten op de pc, selecteer de gewenste camera in het
menu Devices.

5. Plaats de camerakop [5] in de ruimte die u wenst te inspecteren.
Opmerking: De zwanenhals moet gemakkelijk kunnen bewegen. Gebruik dus geen kracht.
6. Draai aan de helderheidsregelaar [1] om de lichtsterkte van de leds in de camerakop te regelen.

7. Om een videobestand op te nemen, stel eerst de standaardmap en bestandsnaam in: kies File >
Set Capture File.

8. Kies Capture > Start Capture en klik op OK om te bevestigen.
De pc start met de opname van het videobestand.
9. Om te stoppen, kies Capture > Stop Capture.

10. Druk op de fotoknop [2] om een foto te nemen. De foto verschijnt in een apart venster. Om de foto
op te slaan, kies File > Save.

11. Eenmaal klaar, sluit het Amcap-programma en ontkoppel de camera van de USB-poort.

w
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Overzicht van de software
Opmerking: Enkel voor Windows Vista / 7.

File Set Capture File instellen van standaard map en bestandsnaam van
opnamebestanden
Allocate File Space instellen van grootte van opnamebestanden
Save Captured Video opslaan van de opname in gewenste map
Exit afsluiten van AmCap-software
Devices lijst met toestellen die met de software verbonden zijn
Options Preview weergeven van real-time beelden
Video Capture Filter instellen van parameters (witbalans, belichting, enz.) en
effecten (afbeelding draaien, enz.)
Video Capture Pin instellen van het formaat van het videovenster
Capture Start Capture opname starten
Stop Capture opname stoppen
Set Frame Rate instellen van aantal frames per seconde
Set Time Limit instellen van maximale opnameduur
8. Reiniging en onderhoud

e Ontkoppel de camera van de computer.
e Maak de camera schoon met een antistatische doek. Gebruik geen alcohol of solvent.
e Spoel de zwanenhals na elk gebruik af met zuiver water en laat hem drogen voor u hem opbergt.

9. Technische specificaties

opneemelement 1/6" CMOS

aantal pixels 640 (H) x 480 (V)

gezichtshoek 56°

focus 6 cm

interface USB 2.0

S/R verhouding 46 dB

witbalans auto

beeldformaat JPEG, BMP

systeemvereisten e  Windows® XP/Vista/Windows 7/Mac OS
e vrije USB 2.0-poort.

IP-waarde IP66 (camera + zwanenhals)

voeding 5 VDC via USB-poort
camera @14 x 72 mm

afmetingen flexibele buis 54 cm
USB-kabel 200 cm

werktemperatuur 0 - 50°C

gewicht 310g¢g

Gebruik dit toestel enkel met originele accessoires. Velleman nv is niet aansprakelijk voor
schade of kwetsuren bij (verkeerd) gebruik van dit toestel.

Voor meer informatie over dit product en de laatste versie van deze handleiding, zie
www.velleman.eu.

De informatie in deze handleiding kan te allen tijde worden gewijzigd zonder voorafgaande
kennisgeving.

Alle geregistreerde handelsmerken en handelsnamen zijn eigendom van hun respectievelijke bezitters, en
zijn enkel gebruikt als voorbeeld van de compatibiliteit tussen onze producten en de producten van de
verschillende fabrikanten. Windows, Windows XP, Windows Vista, Windows 7, zijn geregistreerde
handelsmerken van Microsoft Corporation in de Verenigde Staten en andere landen. Mac, Mac OS, zijn
handelsmerken van Apple Inc., geregistreerd in de Verenigde Staten en andere landen.
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© AUTEURSRECHT

Velleman nv heeft het auteursrecht voor deze handleiding. Alle wereldwijde rechten
voorbehouden. Het is niet toegestaan om deze handleiding of gedeelten ervan over te nemen, te
kopiéren, te vertalen, te bewerken en op te slaan op een elektronisch medium zonder voorafgaande
schriftelijke toestemming van de rechthebbende.

MODE D’EMPLOI

1. Introduction

Aux résidents de I'Union européenne

Des informations environnementales importantes concernant ce produit
Ce symbole sur I'appareil ou I'emballage indique que I'élimination d’un appareil en fin de vie
peut polluer I'environnement. Ne pas jeter un appareil électrique ou électronique (et des piles
éventuelles) parmi les déchets municipaux non sujets au tri sélectif ; une décheterie traitera
I'appareil en question. Renvoyer les équipements usagés a votre fournisseur ou a un service de
recyclage local. Il convient de respecter la réglementation locale relative a la protection de

I 'cnvironnement.

En cas de questions, contacter les autorités locales pour élimination.

Nous vous remercions de votre achat ! Lire la présente notice attentivement avant la mise en service de

I'appareil. Si 'appareil a été endommagé pendant le transport, ne pas l'installer et consulter votre

revendeur.

2. Consignes de sécurité
A Garder hors de la portée des enfants et des personnes non autorisées.
: Ne pas utiliser la caméra a proximité de gaz explosifs.

La téte de la sonde métalliqgue peut dans certains cas exceptionnels provoquer des
courts-circuits. Ne jamais insérer la sonde dans une machine allumée.

sur des personnes ou des animaux. Toute utilisation incorrecte peut causer des blessures
graves.

Il N’y a aucune piece maintenable par I'utilisateur. Commander des piéces de rechange
éventuelles chez votre revendeur.

t Cette caméra ne convient pas a des fins médicales et ne peut en aucun cas étre utilisée
3. Directives générales

Se référer a la garantie de service et de qualité Velleman® en fin de notice.

n @ Protéger contre la poussiéere. Protéger contre la chaleur extréme.

Protéger contre les chocs et le traiter avec circonspection pendant I'opération.
¥

e Se familiariser avec le fonctionnement avant I’emploi.

e Toute modification est interdite pour des raisons de sécurité. Les dommages occasionnés par des
modifications par le client ne tombent pas sous la garantie.

e Nutiliser qu’a sa fonction prévue. Un usage impropre annule d'office la garantie.

e La garantie ne s’applique pas aux dommages survenus en négligeant certaines directives de cette
notice et votre revendeur déclinera toute responsabilité pour les problemes et les défauts qui en
résultent.

e La garantie s’applique uniqguement a la caméra et exclut I'installation et I'utilisation du logiciel inclus.

e Ne pas allumer la caméra aprés exposition a des variations de température. Afin d’éviter des
dommages, attendre jusqu’a ce que la caméra ait atteint la température ambiante avant de I'utiliser.
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e Ne pas utiliser I'appareil en cas de formation de condensation a l'intérieur de I'objectif. Laisser
d'abord I'eau s'évaporer avant de I'utiliser de nouveau.

e La sonde et le col-de-cygne sont étanches et peuvent étre submergés dans un liquide a pH neutre
(donc non acide ou basique). Ne jamais submerger la poignée afin d’éviter des endommagements
irrévocables. Protéger la poignée de la pluie, de 'lhumidité et des projections d’eau.

e Eviter de plier le col-de-cygne de maniére excessive (c.a.d. un rayon de moins de 6 cm).
e Nettoyer la caméra apres chaque utilisation.
e Ne pas utiliser une caméra visiblement endommagée.

4. Caractéristiques

e idéal pour explorer les endroits les moins accessibles comme p.ex. derriére un mur, a l'intérieur d'un
faux plafond, etc.

e 4 LEDs blanches
e intensité des LEDs réglable.

5. Description
Se référer aux illustrations en page 2 de cette notice.

1 bouton pour le réglage de luminosité des LEDs 4  col-de-cygne (£ 60 cm)

2 bouton de capture d’'image 5  téte de caméra avec LED
3 | poignée 6  accessoires : crochet, téte magnétique
6. Préparation

Installer le pilote sur Windows XP ou version ultérieure

Pour un systéeme d'exploitation Windows XP® (ou version ultérieure), procéder comme suit :

1. Connecter la caméra a un port USB 2.0 libre de votre pc.

Remarque : S'assurer d'utiliser un port USB 2.0 ou supérieur. Un fonctionnement correct n'est pas
garanti en cas d'une connexion a un port USB 1.1.

2. Windows reconnait automatiquement I'appareil et installe le pilote. Selon les réglages, Windows
affiche (ou pas) le message “Your new hardware is installed and ready for use” ("Votre nouveau
matériel est installé et prét a I'emploi™).

Votre caméra est préte a I'emploi.

Installer le pilote sur Windows Vista /7 7

Pour Windows Vista / 7, procéder comme suit :

1. Connecter la caméra a un port USB 2.0 libre sur votre pc.
Remarque : S'assurer d'utiliser un port USB 2.0 ou supérieur. Un fonctionnement correct n'est pas
garanti en cas d'une connexion a un port USB 1.1.

2. Glisser le CD-ROM dans le lecteur sur votre pc.

i
3. Double-cliquer sur I'icbne de configurationg pour démarrer l'installation.
4. Suivre les instructions de I'assistant d'installation.

i t
5. Double-cliquer sur I'icbne Amcap [P sur votre bureau pour exécuter le logiciel.
L'installation est maintenant compléte et votre caméra est préte a I'emploi.

Accessoires
Glisser le clip en plastic de I'outil [6] sur la partie étroite de la téte de caméra [5] jusqu'au déclic.

e Placer I'attache magnétique sur la caméra pour ramasser des petites pieces métalliques dans des
endroits difficilement accessible.

e Attacher le crochet pour récupérer des cables ou autres petits objets.
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7. Emploi

A Ne jamais insérer la sonde dans une machine allumée.

Windows XP
1. Connecter la caméra a un port USB 2.0 libre sur votre pc.
2. Ouvrir My Computer et rechercher “USB Video Device” pour regarder des images en direct.
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3. Insérer la téte de caméra [5] dans I'espace a inspecter.
Remarque : Le col-de-cygne doit se manceuvrer aisément en position. Ne pas forcer.
4. Tourner la molette de réglage [1] pour ajuster I'intensité des LEDs dans la téte de caméra.

5. Appuyer sur le bouton de capture [2] pour prendre une photo. La liste de photos apparait au-
dessous de I'image de caméra.

Depuis cette liste, il est possible de copier, supprimer, ou de visualiser les photos.

Windows Vista/ 7
1. Connecter la caméra a un port USB 2.0 libre sur votre pc.

2. Double-cliquer sur I'icbne Amcap & sur votre bureau pour exécuter le logiciel.
Dans le menu Options, sélectionner Preview pour regarder des images en direct.

4. Si plusieurs caméras sont connectées au pc, sélectionner la caméra souhaitée dans le menu
Devices.

5. Insérer la téte de caméra [5] dans I'espace a inspecter.
Remarque : Le col-de-cygne doit se manceuvrer aisément en position. Ne pas forcer.
6. Tourner la molette de réglage [1] pour ajuster I'intensité des LEDs dans la téte de caméra.

7. Pour capturer un fichier video, réglér d'abord le répertoire par défaut et le nom du fichier : choisir
File > Set Capture File.

8. Choisir Capture > Start Capture et cliquer sur OK pour confirmer.
Le pc lance la capture du fichier vidéo.

9. Pour arréter, choisir Capture > Stop Capture.

10. Appuyer sur le bouton de capture [2] pour prendre une photo. La photo apparait dans une fenétre
séparée. Pour sauvegarder la photo, choisir File > Save.

11. Une fois terminée, fermer le programme Amcap et déconnecter la caméra du port USB.

w

Apercu du logiciel
Remarque : Seulement pour Windows Vista / 7.

File Set Capture File régler le répertoire par défaut et le nom du fichier pour des
enregistrements
Allocate File Space configuration de la taille des fichiers d’enregistrement
Save Captured Video sauvegarde du fichier d’enregistrement
Exit fermeture du logiciel AmCap
V. 01 — 06/09/2012 12 ©Velleman nv
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Devices liste d'appareils connectés au logiciel
Options Preview images en temps réel
Video Capture Filter set parameters (white balance, exposure, etc.) and effects
(flip image, etc.)
Video Capture Pin set the size of the video window
Capture Start Capture lancement de I'enregistrement
Stop Capture arrét de I'enregistrement
Set Frame Rate configuration du nombre d’'images par seconde
Set Time Limit configuration de la durée de I'’enregistrement
8. Nettoyage et entretien

e Déconnecter la caméra du port USB.
e Nettoyer la caméra avec un chiffon antistatique. Eviter I'usage d’alcool et de solvants.
e Rincer le col-de-cygne avec de I'eau claire aprés chaque utilisation et laisser sécher avant le

rangement.
9. Spécifications techniques
capteur 1/6" CMOS
nombre de pixels 640 (H) x 480 (V)
angle de vue 56°
focale 6 cm
interface USB 2.0
rapport S/B 46 dB
balance des blancs auto
format d'image JPEG, BMP
systeme requis e Windows® XP/Vista/Windows 7/Mac OS
e port USB 2.0 libre.
indice IP IP66 (caméra + col-de-cygne)
alimentation 5 VCC via port USB
caméra @14 x 72 mm
dimensions tube flexible 54 cm
cable USB 200 cm
température de service 0 —50°C
poids 310¢g

N’employer cet appareil qu’avec des accessoires d’origine. La SA Velleman ne peut, dans la
mesure conforme au droit applicable étre tenue responsable des dommages ou lésions
(directs ou indirects) pouvant résulter de I'utilisation de cet appareil.

Pour plus d’information concernant cet article et la derniére version de cette notice, visiter
notre site web www.velleman.eu.

Toutes les informations présentées dans cette notice peuvent étre modifiées sans notification
préalable.

Les marques déposées et les raisons sociales sont la propriété de leurs détenteurs respectifs, et sont
uniquement utilisées dans le but de démontrer la compatibilité entre nos articles et les articles des
fabricants. Windows, Windows XP, Windows Vista, Windows 7, sont des marques déposées de Microsoft
Corporation aux Etats-Unis et dans d'autres pays. Mac, Mac OS, sont des marques d'Apple Inc., déposées
aux Etats-Unis et dans d'autres pays.

© DROITS D’AUTEUR

SA Velleman est I’ayant droit des droits d’auteur pour cette notice. Tous droits mondiaux
réservés. Toute reproduction, traduction, copie ou diffusion, intégrale ou partielle, du contenu de cette
notice par quelque procédé ou sur tout support électronique que se soit est interdite sans I'accord
préalable écrit de I'ayant droit.
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MANUAL DEL USUARIO

1. Introduccién

A los ciudadanos de la Unién Europea

Importantes informaciones sobre el medio ambiente concerniente a este producto
Este simbolo en este aparato o el embalaje indica que, si tira las muestras inservibles, podrian
dafar el medio ambiente.
No tire este aparato (ni las pilas, si las hubiera) en la basura doméstica; debe ir a una
empresa especializada en reciclaje. Devuelva este aparato a su distribuidor o a la unidad de
reciclaje local. Respete las leyes locales en relacion con el medio ambiente.

I Si tiene dudas, contacte con las autoridades locales para residuos.

iGracias por haber comprado la CAMCOL 14! Lea atentamente las instrucciones del manual antes de

usarla. Si el aparato ha sufrido algin dafio en el transporte no lo instale y péngase en contacto con su

distribuidor.

2. Instrucciones de seguridad
Mantenga el aparato lejos del alcance de personas no capacitadas y nifios.

No utilice la cAmara cerca de gases explosivos.
En algunos casos excepcionales, la cabeza metalica de la sonda puede causar
cortocircuitos. Nunca introduzca la sonda en una maquina activada.

Esta camara no es apta para fines médicos. No utilice nunca el aparato con personas o
animales. Cualquier uso incorrecto puede causar lesiones graves.

El usuario no habra de efectuar el mantenimiento de ninguna pieza. Contacte con su
distribuidor si necesita piezas de recambio.

3. Normas generales
Véase la Garantia de servicio y calidad Velleman ® al final de este manual del usuario.

@ No exponga este equipo a polvo. No exponga este equipo a temperaturas extremas.
(®)
1.
N

e Familiaricese con el funcionamiento del aparato antes de utilizarlo.

e Por razones de seguridad, las modificaciones no autorizadas del aparato estan prohibidas. Los dafios
causados por modificaciones no autorizadas, no estan cubiertos por la garantia.

e Utilice sélo el aparato para las aplicaciones descritas en este manual. Su uso incorrecto anula la
garantia completamente.

e Los dafios causados por descuido de las instrucciones de seguridad de este manual invalidaran su
garantia y su distribuidor no sera responsable de ningin dafio u otros problemas resultantes.

e La garantia so6lo es valida para la camara. No estan incluidos la instalacion y el uso del software
incluido.

e No conecte el aparato si ha estado expuesto a grandes cambios de temperatura. Espere hasta que el
aparato llegue a la temperatura ambiente.

e No utilice el aparato si se ha formado condensacién en la lente. Deje que el agua se evapore antes de
volver a utilizarlo.

e Lasonday el cuello de cisne son resistentes al agua. Es posible sumergirlos en un liquido de pH
neutro (por consiguiente no liquido acido o base). Nunca sumerja el mango para evitar dafios
irrevocables. No exponga el mango a lluvia, humedad ni a ningun tipo de salpicadura o goteo.

e No pliegue el cuello de cisne de manera excesiva (es decir un radio de menos de 6cm).
e Limpie la cAmara después de cada uso.
e No utilice nunca una camara visiblemente dafiada.

No agite el aparato. Evite usar excesiva fuerza durante el manejo y la instalacion.
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4. Caracteristicas

e ideal para explorar lugares de dificil acceso (p.ej. techo falso)
e 4 LEDs blancos
e es posible ajustar la intensidad luminosa de los LEDs.

5. Descripcion
Véase las figuras en la pagina 2 de este manual del usuario.

1 botén de ajuste de la luminosidad LED 4 cuello de cisne (* 60 cm)

2 | botdén de captura de imagen 5 | cabeza de la camara con LED

3 mango 6  accesorios: gancho, cabeza magnética
6. Preparacion

Instalar el driver en Windows XP o una version anterior

Para Windows XP® (o una versién anterior), haga lo siguiente:

1. Conecte la camara a un puerto USB 2.0 libre del PC.
Observacién: Asegurese de que utilice USB 2.0 o superior. No se garantiza un funcionamiento
correcto al utilizar un puerto USB 1.1.

2. Windows reconoce el aparato automaticamente e instale el driver. Dependiendo de los ajustes,
Windows visualiza (0 no) el siguiente mensaje “Your new hardware is installed and ready for use”.

Ahora, la camara esta lista para utilizar.

Instalar el driver en Windows Vista /7 7

Para Windows Vista / 7, haga lo siguiente:

1. Conecte la cAmara a un puerto USB 2.0 libre del PC.
Observacion: Asegurese de que utilice USB 2.0 o superior. No se garantiza un funcionamiento
correcto con USB 1.1.

2. Introduzca el CD-ROM (incl.) en el PC.

3. Haga clic dos veces en el icono de configuracion @ para iniciar la instalacion.
4. Siga las instrucciones del asistente de instalacion.

5. Haga clic dos veces en el icono Amcap del escritorio para iniciar el software.
Ahora, se ha completado la instalacién y la cAmara esta lista para utilizar.

Accesorios
Deslice el gancho de plastico [6] sobre la parte estrecha de la cabeza de la cAmara [5] hasta que se
encaje.

e Ponga la punta magnética en la sonda para recoger pequefias piezas metdlicas en lugares de dificil

acceso.
e Pongale el gancho para retirar cables u otros pequefios objetos.
7. Uso

A Nunca introduzca la sonda en una maquina activada.

Windows XP
1. Conecte la camara a un puerto USB 2.0 libre del PC.
2. Abra My Computer y busque “USB Video Device” para ver imagenes en directo.
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3.

4.
5.

Introduzca la cabeza de la camara [5] en el espacio que quiere inspeccionar.

Observacion: Normalmente, es facil posicionar el cuello de cisne. No lo fuerce.

Ajuste la intensidad de los LEDs con el botén de ajuste [1].

Pulse el botén de captura de imagen [2] para hacer una foto. La lista de fotos se visualiza debajo
de la imagen.

Aqui, es posible copiar, borrar o visualizar las fotos.

Windows Vista / 7

1.

arON

NO

9.
10.

11.

Conecte la camara a un puerto USB 2.0 libre del PC.

Haga clic dos veces en el icono Amcap td del escritorio para iniciar el software.

En el menud Options, seleccione Preview para ver las imagenes en directo.

Seleccione la camara deseada en el menu Devices si estan conectadas méas camaras USB al PC.
Introduzca la cabeza de la cAmara [5] en el espacio que quiere inspeccionar.

Observacion: Normalmente, es facil posicionar el cuello de cisne. No lo fuerce.

Ajuste la intensidad de los LEDs con el botén de ajuste [1].

Para grabar un video, introduzca la carpeta y el nombre del fichero estandar: seleccione File > Set
Capture File.

Seleccione Capture > Start Capture y haga clic en OK para confirmar.

Ahora, el PC empieza a grabar.

Para desactivar, seleccione Capture > Stop Capture.

Pulse el boton de captura de imagen [2] para hacer una foto. La foto se visualiza en otra ventana.
Para guardar la foto, seleccione File > Save.

Si ha terminado, cierre el programa Amcap y desconecta la camara del puerto USB.

Resumen del software
Observacion: sélo para Windows Vista / 7.

File Set Capture File ajustar la carpeta y el nombre del fichero estandar de los
ficheros de grabacion
Allocate File Space ajustar el tamafio de los ficheros de grabacién
Save Captured Video guardar el fichero de grabacion en la carpeta deseada
Exit cerrar el software AmCap
Devices lista de los dispositivos conectados al software
Options Preview iméagenes en tiempo real
Video Capture Filter ajustar los parametros (balance de blancos, exposicion, etc.) y
efectos (girar una imagen, etc.)
Video Capture Pin ajustar el tamafio de la ventana de video
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Capture Start Capture activar la grabacion
Stop Capture desactivar la grabacion
Set Frame Rate ajustar el nimero de iméagenes por segundo
Set Time Limit ajustar la duracion de la grabacion

8. Limpieza y mantenimiento

Desconecte la camara del puerto USB.
Limpie la cAmara con un pafio antiestatico. Evite el uso de alcohol y de disolventes.
Limpie el cuello de cisne con agua clara después de cada uso y deje que se seque antes de

almacenarlo.

9. Especificaciones

elemento de imagen 1/6" CMOS

numero de pixeles 640 (H) x 480 (V)

angulo de vision 56°

foco 6 cm

interfaz USB 2.0

relacién sefial / ruido 46 dB

balance de blancos auto

formato de la imagen JPEG, BMP

exigencias del sistema e  Windows® XP/Vista/Windows 7/Mac OS

e puerto USB 2.0 libre.
IP66 (camara + cuello de cisne)
5 VDC por puerto USB

grado de protecciéon IP
alimentacion

camara @14 x 72 mm
dimensiones tubo 54 cm

cable USB 200 cm
temperatura de funcionamiento 0 — 50°C
peso 310g

Utilice este aparato so6lo con los accesorios originales. Velleman NV no sera responsable de
dafos ni lesiones causados por un uso (indebido) de este aparato.

Para mas informacién sobre este producto y la version mas reciente de este manual del
usuario, visite nuestra pagina www.velleman.eu.

Se pueden modificar las especificaciones y el contenido de este manual sin previo aviso.

Las marcas registradas y el nombre comercial son propiedad de sus propietarios respectivos, y solo se
utilizan para mostrar la compatibilidad entre nuestros productos y los productos de los fabricantes.
Windows, Windows XP, Windows Vista, Windows 7, son marcas comerciales 0 marcas registradas de
Microsoft Corporation en los Estados Unidos y otros paises. Mac, Mac OS, son marcas comerciales de
Apple Inc., registradas en los Estados Unidos y otros paises.

© DERECHOS DE AUTOR

Velleman NV dispone de los derechos de autor para este manual del usuario. Todos los
derechos mundiales reservados. Estéa estrictamente prohibido reproducir, traducir, copiar, editar y
guardar este manual del usuario o partes de ello sin previo permiso escrito del derecho habiente.
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BEDIENUNGSANLEITUNG
1. Einfihrung

An alle Einwohner der Europaischen Union
Wichtige Umweltinformationen Uber dieses Produkt
Dieses Symbol auf dem Produkt oder der Verpackung zeigt an, dass die Entsorgung dieses
Produktes nach seinem Lebenszyklus der Umwelt Schaden zufiigen kann. Entsorgen Sie die
Einheit (oder verwendeten Batterien) nicht als unsortiertes Hausmdll; die Einheit oder
verwendeten Batterien missen von einer spezialisierten Firma zwecks Recycling entsorgt
werden. Diese Einheit muss an den Handler oder ein drtliches Recycling-Unternehmen
I rctourniert werden. Respektieren Sie die 6rtlichen Umweltvorschriften.
Falls Zweifel bestehen, wenden Sie sich fur Entsorgungsrichtlinien an lhre 6rtliche Behorde.
Wir bedanken uns fur den Kauf der CAMCOL14! Lesen Sie diese Bedienungsanleitung vor
Inbetriebnahme sorgféltig durch. Uberpriifen Sie, ob Transportschaden vorliegen. Sollte dies der Fall
sein, verwenden Sie das Gerat nicht und wenden Sie sich an lhren Handler.

2. Sicherheitshinweise
A Halten Sie Kinder und Unbefugte vom Gerat fern.

Betreiben Sie das Gerat nicht in der Nahe von explosiven Gasen.
Der Metallkopf der Kamera kann in Ausnahmefallen einen Kurzschluss verursachen.
Stecken Sie die Kamera nie in ein eingeschaltetes Gerat.

Diese Kamera eignet sich nicht fur medizinische Zwecke. Nicht auf Personen oder Tiere
anwenden. Eine falsche Anwendung kann ernsthafte Verletzungen verursachen.

Es gibt keine zu wartenden Teile. Bestellen Sie eventuelle Ersatzteile bei lhrem
Fachhandler.

3. Allgemeine Richtlinien
Siehe Velleman® Service- und Qualitatsgarantie am Ende dieser Bedienungsanleitung.

. @ Schutzen Sie das Gerat vor Staub. Schitzen Sie das Geréat vor extremen Temperaturen.

n Vermeiden Sie Erschitterungen. Vermeiden Sie rohe Gewalt wéahrend der Installation und
o Bedienung des Gerates.

e Nehmen Sie das Gerét erst in Betrieb, nachdem Sie sich mit seinen Funktionen vertraut gemacht
haben.

e Eigenmaéachtige Veranderungen sind aus Sicherheitsgriinden verboten. Bei Schaden verursacht durch
eigenmachtige Anderungen erlischt der Garantieanspruch.

e Verwenden Sie das Geréat nur fir Anwendungen beschrieben in dieser Bedienungsanleitung sonst
kann dies zu Schaden am Produkt fihren und erlischt der Garantieanspruch.

e Bei Schaden, die durch Nichtbeachtung der Bedienungsanleitung verursacht werden, erlischt der
Garantieanspruch. Fur daraus resultierende Folgeschaden tbernimmt der Hersteller keine Haftung.

e Der Garantieanspruch gilt nur fir das Gerat und nicht fur die mitgelieferte Software.

e Nehmen Sie das Gerat nicht sofort in Betrieb, nachdem es von einem kalten in einen warmen Raum
gebracht wurde. Lassen Sie das Gerat solange ausgeschaltet, bis es die Zimmertemperatur erreicht
hat.

e Verwenden Sie das Geréat nicht, wenn sich Kondenswasser innerhalb des Objektivs gebildet hat.
Warten Sie bis das Wasser verdunstet ist.

e Die Kamera und den Schwanenhals sind wasserdicht und kénnen in eine pH-neutrale Flussigkeit
(keine Saure oder basisch) getaucht werden. Das Eintauchen des Griffes kann zu unwiderruflichen
Schaden fuhren. Schutzen Sie der Griff vor Regen und Feuchte.

e Biegen Sie den Schwanenhals nicht ibermafig; Beachten Sie einen Biegeradios von mindestens
6 cm.
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e Reinigen Sie das Gerat nach jedem Gebrauch.
e Verwenden Sie keine sichtbar beschadigte Kamera.

4. Eigenschaften

e ideal zum Kontrollieren von schwer zuganglichen Stellen (z.B. innerhalb einer abgehéngten Decke)
e 4 weile LEDs
e einstellbare Lichtstarke der LEDs

5. Umschreibung
Siehe Abbildungen, Seite 2 dieser Bedienungsanleitung.

1 Helligkeitsregler fur LED 4 | Schwanenhals (& 60 cm)

2 Schnappschuss-Taste 5  Kamerakopf mit LED-Licht

3  Griff 6  Zubehorteile: Haken, magnetische Spitze

6. Vorbereitung

Den Treiber unter Windows XP oder fruher installieren

FUr Windows XP® (oder friher), gehen Sie wie folgt vor:

1. Verbinden Sie die Kamera mit einem freien USB 2.0-Port an lhrem Computer.

Bemerkung: Verwenden Sie USB 2.0 oder hoher. Verwenden Sie USB 1.1, so kann kein korrektes
Funktionieren nicht gewahrleistet worden.

2. Windows erkennt das Gerat automatisch und installiert den Treiber. Abhéngig von den
Einstellungen, zeigt Windows die Nachricht “Your new hardware is installed and ready for use” an
(oder nicht).

Die Kamera ist nun betriebsfertig.

Den Treiber unter Windows Vista / 7 installieren

Far Windows Vista / 7, gehen Sie wie folgt vor:

1. Verbinden Sie die Kamera mit einem freien USB 2.0-Port an lhrem Computer.
Bemerkung: Verwenden Sie USB 2.0 oder hoher. Verwenden Sie USB 1.1, so kann kein korrektes
Funktionieren nicht gewahrleistet worden.

2. Legen Sie die mitgelieferte CD-ROM in das Laufwerk ein.

i
3. Klicken Sie zwei Mal auf g um die Installation zu starten.

4. Folgen Sie den Anweisungen des Installationsassistenten.
Mic nasoft

5. Klicken Sie zwei Mal auf die Amcap-lkone der Arbeitsoberflache, um die Software zu starten.
Die Installation ist nun abgeschlossen und die Kamera ist betriebsfertig.

Zubehorteile
Schieben Sie den Plastikhaken [6] Uber den schmalen Teil des Kamerakopfes [5] bis dieser einrastet.

e Verbinden Sie den Magnetaufsatz mit der Kamera, um kleine Metallgegenstande an schwer
zuganglichen Stellen aufzunehmen.

e Befestigen Sie den Haken, um Kabel oder andere kleinen Gegenstande zurickzuziehen.

7. Anwendung

A Stecken Sie die Kamera nie in ein eingeschaltetes Gerat.

Windows XP
1. Verbinden Sie die Kamera mit einem freien USB 2.0-Port an lhrem Computer.
2. Offnen Sie My Computer und suchen Sie “USB Video Device” um Live-Bilder zu sehen.
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3. Leiten Sie den Kamerakopf [5] zur Stelle, die Sie untersuchen méchten.
Bemerkung: Der Schwanenhals ist normalerweise einfach zu positionieren. Wenden Sie keine Kraft
an.

4. Stellen die Lichtstarke der LEDs uber den Helligkeitsregler [1] ein.

5. Dricken Sie auf die Schnappschuss-Taste [2] um ein Photo zu machen. Die Liste mit Photos
erscheint unter dem Kamerabild.
Die Bilder kénnen hier kopiert, geléscht oder angesehen werden.

Windows Vista /7 7

1. Verbinden Sie die Kamera mit einem freien USB 2.0-Port an lhrem Computer.
- ”

2. Klicken Sie zwei Mal auf die Amcap-lkone [d der Arbeitsoberflache, um die Software zu starten.

Im Menl Options, wéhlen Sie Preview wenn Sie sich die Live-Bilder ansehen mochten.

4. Sind mehrere USB-Kameras an den PC angeschlossen, dann wahlen Sie die gewilinschte Kamera im
Menu Devices.

5. Leiten Sie den Kamerakopf [5] zur Stelle, die Sie untersuchen méchten.
Bemerkung: Der Schwanenhals ist normalerweise einfach zu positionieren. Wenden Sie keine Kraft
an.

6. Stellen die Lichtstarke der LEDs Uber den Helligkeitsregler [1] ein.

7. Um eine Video-Aufnahme zu machen, geben Sie zuerst den Standard-Ordner und den Dateinamen
ein: wahlen Sie File > Set Capture File.

8. Wabhlen Sie Capture > Start Capture und klicken Sie auf OK um zu bestétigen.
Der PC startet die Aufnahme.

9. Um zu stoppen, wéahlen Sie Capture > Stop Capture.

10. Drucken Sie die Schnappschuss-Taste [2] um ein Photo zu machen. Das Photo erscheint in einem
anderen Fenster. Um das Photo zu speichern, wahlen Sie File > Save.

11. Wenn Sie stoppen, schlieBen Sie das Amcap-Programm und trennen Sie die Kamera vom USB-Port.

w

Ubersicht der Software
Bemerkung: Nur fur Windows Vista / 7.

File Set Capture File den Standard-Ordner und den Dateiname der
Aufnahmedateien einstellen
Allocate File Space die GroRe der Aufnahmedateien einstellen
Save Captured Video die Aufnahme in den gewiinschten Ordner speichern
Exit die AmCap-Software schlielen
Devices Liste mit Geraten, die an die Software angeschlossen sind
Options Preview Echtzeitbilder anzeigen
Video Capture Filter Parameter einstellen (Weifl3balance, Belichtung, usw.) und
Effekte (Bild drehen, usw.)
Video Capture Pin die Grol3e des Videofensters einstellen
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die Aufnahme starten

die Aufnahme stoppen

die Anzahl Frames per Sekunde einstellen
die Aufnahmedauer einstellen

Capture Start Capture
Stop Capture
Set Frame Rate

Set Time Limit

8. Reinigung und Wartung

e Trennen Sie die Kamera vom PC.

e Reinigen Sie die Kamera mit einem antistatischen Tuch. Verwenden Sie auf keinen Fall Alkohol oder
irgendwelche Lésungsmittel.

e Spilen Sie den Schwanenhals nach jedem Gebrauch mit sauberem Wasser und lassen Sie ihn
trocknen, bevor Sie ihn im Koffer lagern.

9. Technische Daten
Aufnahme-Element 1/6" CMOS
Pixelanzahl 640 (H) x 480 (V)
Betrachtungswinkel 56°

Fokus 6 cm
Schnittstelle USB 2.0

S/N Rate 46 dB
Weil3abgleich automatisch
Bildformat JPEG, BMP

Systemvoraussetzungen

IP-Schutzart

e Windows® XP/Vista/Windows 7/Mac OS
e freier USB 2.0-Port
IP66 (Kamera + Schwanenhals)

Stromversorgung 5 VDC uber USB-Port
Kamera @ 14 x 72 mm
Abmessungen Schlauch 54 cm
USB-Kabel 200 cm
Betriebstemperatur 0 - 50°C
Gewicht 310¢g

Verwenden Sie dieses Gerat nur mit originellen Zubehorteilen. Velleman NV Ubernimmt keine
Haftung fur Schaden oder Verletzungen bei (falscher) Anwendung dieses Gerates.

Fur mehr Informationen zu diesem Produkt und die neueste Version dieser
Bedienungsanleitung, siehe www.velleman.eu.

Alle Anderungen ohne vorherige Ankiindigung vorbehalten.

Alle registrierten Schutzmarken und Handelsnamen sind das Eigentum lhrer jeweiligen Eigentimer und
werden nur als Beispiel verwendet, um die Kompatibilitat zwischen unseren Artikeln und diesen der
verschiedenen Fabrikanten anzuzeigen. Windows, Windows XP, Windows Vista, Windows 7, sind
eingetragene Warenzeichen von Microsoft Corporation in den USA und anderen Landern. Mac, Mac OS,
sind Warenzeichen von Apple Inc., eingetragen in den USA und anderen Landern.

© URHEBERRECHT

Velleman NV besitzt das Urheberrecht fur diese Bedienungsanleitung. Alle weltweiten Rechte
vorbehalten. Ohne vorherige schriftliche Genehmigung des Urhebers ist es nicht gestattet, diese
Bedienungsanleitung ganz oder in Teilen zu reproduzieren, zu kopieren, zu Ubersetzen, zu bearbeiten
oder zu speichern.

V. 01 — 06/09/2012 21 ©Velleman nv




LEN

Velleman® Service and Quality Warranty

Since its foundation in 1972, Velleman® acquired extensive experience in
the electronics world and currently distributes its products in over 85
countries.

All our products fulfil strict quality requirements and legal stipulations in
the EU. In order to ensure the quality, our products regularly go through
an extra quality check, both by an internal quality department and by
specialized external organisations. If, all precautionary measures
notwithstanding, problems should occur, please make appeal to our
warranty (see guarantee conditions).

Ge?eral Warranty Conditions Concerning Consumer Products (for
EUV):

+ All consumer products are subject to a 24-month warranty on production
flaws and defective material as from the original date of purchase.

+ Velleman® can decide to replace an article with an equivalent article, or
to refund the retail value totally or partially when the complaint is valid and
a free repair or replacement of the article is impossible, or if the expenses
are out of proportion.

You will be delivered a replacing article or a refund at the value of 100%
of the purchase price in case of a flaw occurred in the first year after the
date of purchase and delivery, or a replacing article at 50% of the
purchase price or a refund at the value of 50% of the retail value in case
of a flaw occurred in the second year after the date of purchase and
delivery.

« Not covered by warranty:

- all direct or indirect damage caused after delivery to the article (e.g. by
oxidation, shocks, falls, dust, dirt, humidity...), and by the article, as well
as its contents (e.g. data loss), compensation for loss of profits;

- consumable goods, parts or accessories that are subject to an aging
process during normal use, such as batteries (rechargeable, non-
rechargeable, built-in or replaceable), lamps, rubber parts, drive belts...
(unlimited list);

- flaws resulting from fire, water damage, lightning, accident, natural
disaster, etc....;

- flaws caused deliberately, negligently or resulting from improper
handling, negligent maintenance, abusive use or use contrary to the
manufacturer’s instructions;

- damage caused by a commercial, professional or collective use of the
article (the warranty validity will be reduced to six (6) months when the
article is used professionally);

- daTage resulting from an inappropriate packing and shipping of the
article;

- all damage caused by modification, repair or alteration performed by a
third party without written permission by Velleman®.

+ Articles to be repaired must be delivered to your Velleman® dealer,
solidly packed (preferably in the original packaging), and be completed
with the original receipt of purchase and a clear flaw description.

« Hint: In order to save on cost and time, please reread the manual and
check if the flaw is caused by obvious causes prior to presenting the
article for repair. Note that returning a non-defective article can also
involve handling costs.

* Repairs occurring after warranty expiration are subject to shipping costs.
+ The above conditions are without prejudice to all commercial warranties.
The above enumeration is subject to modification according to the
article (see article’s manual).

vervangend product of terugbetaling ter waarde van 100% van de
aankoopsom bij ontdekking van een gebrek tot één jaar na aankoop en
levering, of een vervangend product tegen 50% van de kostprijs of
terugbetaling van 50 % bij ontdekking na één jaar tot 2 jaar.

+ Valt niet onder waarborg:

- alle rechtstreekse of onrechtstreekse schade na de levering veroorzaakt
aan het toestel (bv. door oxidatie, schokken, val, stof, vuil, vocht...), en
door het toestel, alsook zijn inhoud (bv. verlies van data), vergoeding voor
eventuele winstderving.

- verbruiksgoederen, onderdelen of hulpstukken die onderhevig zijn aan
veroudering door normaal gebruik zoals bv. batterijen (zowel oplaadbare
als niet-oplaadbare, ingebouwd of vervangbaar), lampen, rubberen
onderdelen, aandrijfriemen... (onbeperkte lijst).

- defecten ten gevolge van brand, waterschade, bliksem, ongevallen,
natuurrampen, enz.

- defecten veroorzaakt door opzet, nalatigheid of door een
onoordeelkundige behandeling, slecht onderhoud of abnormaal gebruik of
gebruik van het toestel strijdig met de voorschriften van de fabrikant.

- schade ten gevolge van een commercieel, professioneel of collectief
gebruik van het apparaat (bij professioneel gebruik wordt de
garantieperiode herleid tot 6 maand).

- schade veroorzaakt door onvoldoende bescherming bij transport van het
apparaat.

- alle schade door wijzigingen, reparaties of modificaties uitgevoerd door
derden zonder toestemming van Velleman®.

+ Toestellen dienen ter reparatie aangeboden te worden bij uw
Velleman®-verdeler. Het toestel dient vergezeld te zijn van het
oorspronkelijke aankoopbewijs. Zorg voor een degelijke verpakking (bij
voorkeur de originele verpakking) en voeg een duidelijke foutomschrijving

bij.

« Tip: alvorens het toestel voor reparatie aan te bieden, kijk nog eens na
of er geen voor de hand liggende reden is waarom het toestel niet naar
behoren werkt (zie handleiding). Op deze wijze kunt u kosten en tijd
besparen. Denk eraan dat er ook voor niet-defecte toestellen een kost
voor controle aangerekend kan worden.

« Bij reparaties buiten de waarborgperiode zullen transportkosten
aangerekend worden.

+ Elke commerciéle garantie laat deze rechten onverminderd.
Bovenstaande opsomming kan eventueel aangepast worden
naargelang de aard van het product (zie handleiding van het
betreffende product).

«»

Velleman® service- en kwaliteitsgarantie

Velleman® heeft sinds zijn oprichting in 1972 een ruime ervaring
opgebouwd in de elektronicawereld en verdeelt op dit moment producten
in meer dan 85 landen. Al onze producten beantwoorden aan strikte
kwaliteitseisen en aan de wettelijke bepalingen geldig in de EU. Om de
kwaliteit te waarborgen, ondergaan onze producten op regelmatige
tijdstippen een extra kwaliteitscontrole, zowel door onze eigen
kwaliteitsafdeling als door externe gespecialiseerde organisaties. Mocht
er ondanks deze voorzorgen toch een probleem optreden, dan kunt u
steeds een beroep doen op onze waarborg (zie waarborgvoorwaarden).
Algemene waarborgvoorwaarden consumentengoederen (voor
Europese Unie):

« Op alle consumentengoederen geldt een garantieperiode van 24
maanden op productie- en materiaalfouten en dit vanaf de oorspronkelijke
aankoopdatum.

« Indien de klacht gegrond is en een gratis reparatie of vervanging van
een artikel onmogelijk is of indien de kosten hiervoor buiten verhouding
zijn, kan Velleman® beslissen het desbetreffende artikel te vervangen
door een gelijkwaardig artikel of de aankoopsom van het artikel
gedeeltelijk of volledig terug te betalen. In dat geval krijgt u een
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Garantie de service et de qualité Velleman®

Depuis 1972, Velleman® a gagné une vaste expérience dans le secteur
de I'électronique et est actuellement distributeur dans plus de 85 pays.
Tous nos produits répondent & des exigences de qualité rigoureuses et a
des dispositions 1égales en vigueur dans 'UE. Afin de garantir la qualité,
nous soumettons regulierement nos produits a des controles de qualité
supplémentaires, tant par notre propre service qualité que par un service
qualité externe. Dans le cas improbable d'un défaut malgreé toutes les
précautions, il est possible d'invoquer notre garantie (voir les conditions
de garantie).

Conditions générales concernant la garantie sur les produits grand
public (pour I'UE) :

« tout produit grand public est garanti 24 mois contre tout vice de
production ou de matériaux a dater du jour d'acquisition effective ;

« si la plainte est justifiée et que la réparation ou le remplacement d'un
article est jugé impossible, ou lorsque les codts s'averent
disproportionnés, Velleman® s'autorise a remplacer ledit article par un
article équivalent ou a rembourser la totalité ou une partie du prix d’achat.
Le cas échéant, il vous sera consenti un article de remplacement ou le
remboursement complet du prix d'achat lors d'un défaut dans un délai de
1 an apreés 'achat et la livraison, ou un article de remplacement
moyennant 50% du prix d'achat ou le remboursement de 50% du prix
d'achat lors d'un défaut aprés 1 a 2 ans.

« sont par conséquent exclus :

- tout dommage direct ou indirect survenu a l'article apres livraison (p.ex.
dommage lié a I'oxydation, choc, chute, poussiére, sable, impureté...) et
provoqué par I'appareil, ainsi que son contenu (p.ex. perte de données) et
une indemnisation éventuelle pour perte de revenus ;

- toute piece ou accessoire nécessitant un remplacement causé par un
usage normal comme p.ex. piles (rechargeables comme non
rechargeables, intégrées ou remplagables), ampoules, pieces en
caoutchouc, courroies... (liste illimitée) ;

- tout dommage qui résulte d'un incendie, de la foudre, d’un accident,
d’'une catastrophe naturelle, etc. ;



- out dommage provoqué par une négligence, volontaire ou non, une

utilisation ou un entretien incorrect, ou une utilisation de I'appareil

contraire aux prescriptions du fabricant ;

- tout dommage a cause d'une utilisation commerciale, professionnelle ou

collective de 'appareil (la période de garantie sera réduite a 6 mois lors

d'une utilisation professionnelle) ;

- tout dommage a I'appareil qui résulte d’une utilisation incorrecte ou

différente que celle pour laquelle il a été initialement prévu comme décrit

dans la notice ;

- tout dommage engendré par un retour de I'appareil emballé dans un

conditionnement non ou insuffisamment protégé.

- toute réparation ou modification effectuée par une tierce personne sans

I'autorisation explicite de SA Velleman® ; - frais de transport de et vers

Velleman® si 'appareil n'est plus couvert sous la garantie.

« toute réparation sera fournie par I'endroit de 'achat. L'appareil doit

nécessairement étre accompagné du bon d’achat d'origine et étre dliment

go?diti)onné (de préférence dans I'emballage d'origine avec mention du
éfaut) ;

« tuyau : il est conseillé de consulter la notice et de controler cables, piles,

etc. avant de retourner I'appareil. Un appareil retourné jugé défectueux

qui s'avere en bon état de marche pourra faire I'objet d’une note de frais &

charge du consommateur ;

* une réparation effectuée en-dehors de la période de garantie fera 'objet

de frais de transport ;

« toute garantie commerciale ne porte pas atteinte aux conditions

susmentionnées.

La liste susmentionnée peut étre sujette & une complémentation

selon le type de I'article et étre mentionnée dans la notice d’emploi.

+ Cualquier articulo que tenga que ser reparado tendra que ser devuelto a
su distribuidor Velleman®. Devuelva el aparato con la factura de compra
original y transportelo en un embalaje sélido (preferentemente el
embalaje original). Incluya también una buena descripcion del fallo;

« Consejo: Lea el manual del usuario y controle los cables, las pilas, etc.
antes de devolver el aparato. Si no se encuentra un defecto en el articulo
los gastos podrian correr a cargo del cliente;

« Los gastos de transporte correran a carga del cliente para una
reparacion efectuada fuera del periodo de garantia.

+ Cualquier gesto comercial no disminuye estos derechos.

La lista previamente mencionada puede ser adaptada segun el tipo
de articulo (véase el manual del usuario del articulo en cuestion).

L ES

Garantia de servicio y calidad Velleman®

Desde su fundacion en 1972 Velleman® ha adquirido una amplia
experiencia como distribuidor en el sector de la electrénica en mas de 85
paises. Todos nuestros productos responden a normas de calidad
rigurosas y disposiciones legales vigentes en la UE. Para garantizar la
calidad, sometemos nuestros productos regularmente a controles de
calidad adicionales, tanto a través de nuestro propio servicio de calidad
como de un servicio de calidad externo. En el caso improbable de que
surgieran problemas a pesar de todas las precauciones, es posible
recurrir a nuestra garantia (véase las condiciones de garantia).
Condiciones generales referentes a la garantia sobre productos de
venta al publico (para la Unién Europea):

« Todos los productos de venta al pablico tienen un periodo de garantia
de 24 meses contra errores de produccion o errores en materiales desde
la adquisicion original;

* Sila queja esta fundada y si la reparacion o sustitucion de un articulo no
es posible, o si los gastos son desproporcionados, Velleman® autoriza
reemplazar el articulo por un articulo equivalente o reembolsar la
totalidad o una parte del precio de compra. En este caso, usted recibira
un articulo de recambio o el reembolso completo del precio de compra si
encuentra algun fallo hasta un afio después de la compra y entrega, 0 un
articulo de recambio al 50% del precio de compra o el reembolso del 50%
del precio de compra si encuentra un fallo después de 1 afio y hasta los 2
afios después de la compra y entrega.

Por consiguiente, estan excluidos entre otras cosas:

- todos los dafios causados directa o indirectamente al aparato (p.ej. por
oxidacion, choques, caida,...) y a su contenido (p.ej. pérdida de datos)
después de la entrega y causados por el aparato, y cualquier
indemnizacion por posible pérdida de ganancias;

- partes 0 accesorios, que estén expuestos al desgaste causado por un
uso normal, como por ejemplo baterias (tanto recargables como no
recargables, incorporadas o reemplazables), bombillas, partes de goma,
etc. (lista ilimitada);

- defectos causados por un incendio, dafios causados por el agua, rayos,
accidentes, catastrofes naturales, etc.;

- defectos causados a conciencia, descuido o por malos tratos, un
mantenimiento inapropiado o un uso anormal del aparato contrario a las
instrucciones del fabricante;

- dafios causados por un uso comercial, profesional o colectivo del
aparato (el periodo de garantia se reducird a 6 meses con uso
profesional);

- dafios causados por un uso incorrecto o un uso ajeno al que esta
previsto el producto inicialmente como esta descrito en el manual del
usuario;

- dafios causados por una proteccion insuficiente al transportar el
aparato.

- dafios causados por reparaciones o modificaciones efectuadas por una
tercera persona sin la autorizacion explicita de Velleman®;

- se calcula gastos de transporte de y a Velleman® si el aparato ya no
esta cubierto por la garantia.
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Velleman® Service- und Qualitatsgarantie

Seit der Grindung in 1972 hat Velleman® sehr viel Erfahrung als Verteiler
in der Elektronikwelt in Uber 85 Landern aufgebaut.

Alle Produkte entsprechen den strengen Qualitatsforderungen und
gesetzlichen Anforderungen in der EU. Um die Qualitat zu gewahrleisten
werden unsere Produkte regelmaBig einer zusatzlichen Qualitatskontrolle
unterworfen, sowohl von unserer eigenen Qualitatsabteilung als auch von
externen spezialisierten Organisationen. Sollten, trotz aller
Vorsichtsma3nahmen, Probleme auftreten, nehmen Sie bitte die Garantie
in Anspruch (siehe Garantiebedingungen).

Allgemeine Garantiebedingungen in Bezug auf Konsumgiiter (fiir die
Europdische Union):

+ Alle Produkte haben fur Material- oder Herstellungsfehler eine
Garantieperiode von 24 Monaten ab Verkaufsdatum.

+» Wenn die Klage berechtigt ist und falls eine kostenlose Reparatur oder
ein Austausch des Gerétes unmdglich ist, oder wenn die Kosten daftir
unverh&ltnismaBig sind, kann Velleman® sich dariber entscheiden,
dieses Produkt durch ein gleiches Produkt zu ersetzen oder die
Kaufsumme ganz oder teilweise zurlickzuzahlen. In diesem Fall erhalten
Sie ein Ersatzprodukt oder eine Riickzahlung im Werte von 100% der
Kaufsumme im Falle eines Defektes bis zu 1 Jahr nach Kauf oder
Lieferung, oder Sie bekommen ein Ersatzprodukt im Werte von 50% der
Kaufsumme oder eine Riickzahlung im Werte von 50 % im Falle eines
Defektes im zweiten Jahr.

+ Von der Garantie ausgeschlossen sind:

- alle direkten oder indirekten Schaden, die nach Lieferung am Gerat und
durch das Gerét verursacht werden (z.B. Oxidation, StéRe, Fall, Staub,
Schmutz, Feuchtigkett, ...), sowie auch der Inhalt (z.B. Datenverlust),
Entschadigung fiir eventuellen Gewinnausfall.

- Verbrauchsguter, Teile oder Zubehorteile, die durch normalen Gebrauch
dem Verschlei} ausgesetzt sind, wie z.B. Batterien (nicht nur aufladbare,
sondern auch nicht aufladbare, eingebaute oder ersetzbare), Lampen,
Gummiteile, Treibriemen, usw. (unbeschrénkte Liste).

- Schéden verursacht durch Brandschaden, Wasserschaden, Blitz,
Unfélle, Naturkatastrophen, usw.

- Schaden verursacht durch absichtliche, nachléssige oder
unsachgeméaRe Anwendung, schlechte Wartung, zweckentfremdete
Anwendung oder Nichtbeachtung von Benutzerhinweisen in der
Bedienungsanleitung.

- Schéden infolge einer kommerziellen, professionellen oder kollektiven
Anwendung des Gerétes (bei gewerblicher Anwendung wird die
Garantieperiode auf 6 Monate zuriickgefihrt).

- Schaden verursacht durch eine unsachgeméRe Verpackung und
unsachgeméafen Transport des Gerates. .

- alle Schéaden verursacht durch unautorisierte Anderungen, Reparaturen
oder Modifikationen, die von einem Dritten ohne Erlaubnis von Velleman®
vorgenommen werden.

« Im Fall einer Reparatur, wenden Sie sich an lhren Velleman®-Verteiler.
Legen Sie das Produkt ordnungsgemaR verpackt (vorzugsweise die
Originalverpackung) und mit dem Original-Kaufbeleg vor. Fiigen Sie eine
deutliche Fehlerbeschreibung hinzu.

« Hinweis: Um Kosten und Zeit zu sparen, lesen Sie die
Bedienungsanleitung nochmals und Uberpriifen Sie, ob es keinen auf de
Hand liegenden Grund gibt, ehe Sie das Gerét zur Reparatur
zuriickschicken. Stellt sich bei der Uberpriifung des Gerétes heraus, dass
kein Gerateschaden vorliegt, kdnnte dem Kunden eine
Untersuchungspauschale berechnet.

« Fiir Reparaturen nach Ablauf der Garantiefrist werden Transportkosten
berechnet.

+ Jede kommerzielle Garantie lésst diese Rechte unbertihrt.

Die oben stehende Aufzahlung kann eventuell angepasst werden
geman der Art des Produktes (siehe Bedienungsanleitung des
Gerates).
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